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SDS-MW Analysis Kit

The SCIEX SDS-MW Analysis Kit provides reagents and supplies for sample preparation and methods to resolve 

both reduced and non-reduced proteins using the PA 800 Plus Pharmaceutical Analysis System.

This document provides instructions for sample preparation and methods to resolve both reduced and non-
reduced proteins by size using the PA 800 Plus Pharmaceutical Analysis System.

Safety

Refer to the Safety Data Sheets (SDS), available at sciex.com/tech-regulatory, for information about the proper 
handling of materials and reagents. Always follow standard laboratory safety guidelines. Refer to Hazardous 
Substance Information for hazardous substances information.

Intended Use

The SDS-MW Analysis Kit is for laboratory use only.

Introduction

Capillary electrophoresis (CE) has become an effective replacement for manual slab gel electrophoresis processes 
due to its automation, quantitation, fast speed, and high efficiency. Many biomolecules, such as proteins, 
carbohydrates, and nucleic acids are separated by molecular sieving electrophoresis using gel matrices, a 
technique referred to as capillary gel electrophoresis (CGE). The separation results from the differential 
migration of the analyte through a gel matrix. In this case, smaller molecules will move faster than large 
molecules through the separation gel. For polypeptides and proteins, it is necessary to denature the sample in the 
presence of SDS, an anionic detergent that binds the proteins in a constant ratio of 1:1.4 of protein. The constant 
mass-to-charge property of the SDS-bound proteins allows separation in a constant ratio of 1 gram of protein : 1.4 
grams of SDS.

Note: Refer to the System Overview Guide for instructions for safe use of the system.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System
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SDS-MW Analysis Kit
The methodology involves the separation of protein-SDS complexes using a replaceable gel matrix. The gel is 
formulated to provide an effective sieving range of approximately 10 kDa to 225 kDa. Within this size range, 
the logarithm of protein molecular mass is linear with its reciprocal electrophoretic mobility. Therefore, the 
molecular weight of an unknown protein may be estimated from a standard curve of known protein sizes. This 
kit can also be used to quantify the amount of protein and to determine the purity of a protein product.

Protein Size Standard

The SDS-MW Size Standard contains 10 kDa, 20 kDa, 35 kDa, 50 kDa, 100 kDa, 150 kDa, and 225 kDa proteins. 
The SDS-MW Size Standard is used to calibrate the gel to estimate the protein molecular weight of the sample. 
It also provides confirmation of the resolving power of your experiment.

Internal Standard

A 10 kDa protein Internal Standard is used as a mobility marker. The mobility of all protein samples are 
calculated relative to this mobility marker allowing for more accurate size estimation and analyte 
identification.

Sample Buffers

 • SDS-MW Sample Buffer: The SDS-MW Sample Buffer is provided as part of the SDS-MW Analysis Kit. This 
buffer consists of 100 mM Tris-HCl at pH 9.0 with 1% SDS.

 • Low pH SDS sample buffers: In some cases, a sample buffer with a lower pH (than that of the SDS-MW 
Sample Buffer) might improve sample stability by minimizing protein degradation. For these samples, the 
SCIEX low pH SDS sample buffers are available separately:

— Low pH SDS Sample Buffer: This buffer consists of 100 mM Tris-HCl at pH 6.8 with 1% SDS.

— Low pH Phosphate SDS Sample Buffer: This buffer consists of 40 mM Phosphate at pH 6.5 with 1% SDS. 
This buffer meets the China Pharmacopeia specification.

Note: This application guide has been validated with the PA 800 Plus Pharmaceutical Analysis System.
SDS-MW Analysis Kit For the PA 800 Plus 
Pharmaceutical Analysis System
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SDS-MW Analysis Kit
Equipment and Materials Required

Note: For items with a reorder part number, sometimes the reorder quantity is different than the quantity in 
the kit.

Table 1  Kit Contents (PN 390953)

Component Quantity Reorder Part 
Number

Capillary, 50 μm i.d. bare-fused silica 2 338451

SDS-MW Gel Buffer, proprietary formulation, pH 8.0, 0.2% SDS 140 mL, 4-pack A30341

SDS-MW Sample Buffer, 100 mM Tris-HCl, pH 9.0, 1% SDS 50 mL N/A

SDS-MW Size Standard, 10 kDa to 225 kDa, 16 mg/mL 100 μL A22196

Internal Standard, 10 kDa protein, 5 mg/mL 0.4 mL A26487

Acid Wash/Regenerating Solution, 0.1 M HCl 100 mL N/A

Basic Wash Solution, 0.1 M NaOH 100 mL 338424

Table 2  Additional Supplies from SCIEX

Component Quantity Part Number

(Optional) Low pH SDS Sample Buffer, 100 mM Tris-HCl, pH 6.8, 1% SDS 140 mL C44807

(Optional) Low pH Phosphate SDS Sample Buffer, 40 mM Phosphate, pH 6.5, 1% SDS 140 mL C57805

Micro Vials, 200 μL 100 144709

Universal Vial caps, blue 100 A62250

Universal Vials 100 A62251

Table 3  Additional Required Reagents and Equipment

Component Quantity Part Number

2-mercaptoethanol Sigma-Aldrich M7154

Iodoacetamide Sigma-Aldrich I-1149

(Optional) Amicon Ultra-4 Centrifugal Filter Unit with Ultracel-10 membrane Millipore UFC801024
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System
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SDS-MW Analysis Kit
Storage Conditions

 • Upon receipt, store the SDS-MW Size Standard and 10 kDa Internal Standard at 2 °C to 8 °C.

 • Store the capillary, SDS-MW Sample Buffer, SDS-MW Gel Buffer, Acid Wash/Regenerating Solution, and 
Basic Wash Solution at room temperature.

 • Store the Low pH SDS Sample Buffer and Low pH Phosphate SDS Sample Buffer at room temperature.

Customer-Supplied Equipment and Supplies

 • Powder-free gloves, neoprene or nitrile recommended

 • Safety glasses

 • Laboratory coat

 • Table-top mini centrifuge

 • Microcentrifuge, or equivalent, and microcentrifuge tubes

 • Water bath or heat block, 37 °C to 100 °C

 • Vortex mixer

 • Analytical balance

 • Pipettes and appropriate tips

 • Parafilm

 • Spatula

 • Double-deionized (DDI) water (MS-grade water filtered through a 0.2 μm filter and with resistance greater 
than 18 MΩ)

Required Detector

A photodiode array (PDA) detector is required.

Required Cartridge or Capillary

One of the following:

 • Pre-assembled cartridge (PN A55625)

 • Capillary cartridge (PN 144738) and capillaries, bare-fused silica, 50 μm i.d. (PN 338451)

 • Cartridge Rebuild Kit (PN 144645)

Note: If the gel buffer or sample buffers are refrigerated, then precipitates might form. If precipitates are 
present, stir the buffer until the precipitate is fully dissolved before using.
SDS-MW Analysis Kit For the PA 800 Plus 
Pharmaceutical Analysis System

Application Guide
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SDS-MW Analysis Kit
Methods and Sequences

The methods and data files are installed on the PA 800 Plus controller. They are not available for download. 
The methods and sequence can also be created manually with the 32 Karat™ Software. Refer to Methods.

The methods are in the PA 800 Plus controller at C:\32Karat\projects\SDS-MW\Method.

 • SDS MW Conditioning - PA 800 plus.met: Conditions the capillary at the start of each day.

 • SDS MW Separation - PA 800 plus.met: Performs an SDS-MW separation.

 • SDS MW Shutdown - PA 800 plus.met: Shuts down and cleans the capillary at the end of a sequence, to rinse 
the capillary for storage, and to turn off the UV lamp (turns off the laser in the PDA detector).

The sequence file is in the PA 800 Plus controller at C:\32Karat\projects\SDS-MW\Sequence.

 • SDS MW - 24 samples - PA 800 plus.seq

Prepare the Samples

Prepare the SDS-MW Size Standard

1 Thaw the SDS-MW Size Standard at room temperature for 15 minutes.

2 Mix the SDS-MW Size Standard thoroughly and using a standard microcentrifuge, spin the tube briefly.

3 Pipette 10 μL of the SDS-MW Size Standard into a 0.5 mL microcentrifuge tube.

4 Add 85 μL of the SDS-MW Sample Buffer to the microcentrifuge tube.

5 Add 2 μL of the 10 kDa Internal Standard to the microcentrifuge tube.

6 Inside a fume hood, add 5 μL of 2-mercaptoethanol to the microcentrifuge tube.

7 Seal the vial cap with Parafilm, mix thoroughly, and heat in a water bath at 100 °C for three minutes.

Note: The following information applies to users using the PA 800 Plus System with the PA 800 Plus and 
32 Karat™ Software. If the system will be used with the Empower™ Software, then the methods are different. 
Refer to Run the Samples with the Waters Empower™ Software.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System
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SDS-MW Analysis Kit
8 Using a centrifuge, spin the tube for 1 minute at 300 g.

9 Put the tube in a room-temperature water bath to cool for five minutes before injection. The sample will 

remain stable for approximately 24 hours.

10 Transfer 70 μL to 90 μL of the prepared sample to a micro vial, put the micro vial inside a universal vial, 

then cap the universal vial.

Perform a Buffer Exchange for the Protein Sample

1 Add 1 mL of protein sample to filter unit.

2 Using a centrifuge, spin the sample for 15 minutes at 4,000 g.

3 Add 2 mL of SDS-MW Sample Buffer, then use a centrifuge and spin for 25 minutes at 4,000 g.

4 Put the filter unit into a new vial in an inverted position and then use a centrifuge to spin the vial for 

3 minutes at 1,000 g. The protein solution will collect in the vial.

5 Transfer the collected protein to an appropriate sterile tube. Add SDS-MW Sample Buffer to give a final 

volume of 1 mL.

Determine the Protein Sample Concentration

After addition of the SDS-MW Sample Buffer, the total protein concentration should be between 0.2 mg/mL 
to 2 mg/mL. For best results, the recommended protein concentration is 1 mg/mL. If the protein 
concentration is too high, it can result in insufficient SDS binding, giving broad peaks and poor resolution. If 
the protein concentration is too low, a low signal is likely to occur.

Note: The signal intensity and resolution of this assay are sensitive to the salt concentration in the protein 
sample. If the sample concentration is too high, then low signal and peak tailing is likely to occur. Exchange 
the SDS-MW Sample Buffer with an Amicon Ultra-4 centrifugal filter unit using the following procedure.

Note: For desalting/buffer exchange procedures using a device from another vendor, read the user guide 
from the vendor before use.
SDS-MW Analysis Kit For the PA 800 Plus 
Pharmaceutical Analysis System
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SDS-MW Analysis Kit
Prepare the Reduced Protein Sample

Reduction of the disulfide bonds will provide a more accurate assessment of the molecular weight of a protein, 
and will allow you to gain additional structural information on a given protein.

1 Dilute the sample with the SDS-MW Sample Buffer to a total volume of 95 μL to give a final protein 

concentration between 0.2 mg/mL to 2 mg/mL.

2 Add 2 μL of the 10 kDa Internal Standard to the protein sample tube.

3 Inside a fume hood, add 5 μL of 2-mercaptoethanol to the protein sample tube.

4 Cap the tube tightly, seal with Parafilm, and mix thoroughly.

5 Heat the tube in a water bath at 100 °C for 3 minutes.

6 Using a centrifuge, spin the tube for 1 minute at 300 g.

7 Put the tube in a room-temperature water bath to cool for 5 minutes before injection.

8 Transfer 70 μL to 90 μL of the prepared sample to a micro vial. Put the micro vial inside a universal vial, 

then cap the universal vial. Make sure there are no bubbles in the micro vial.

Prepare the Non-reduced Protein Sample

Comparison of the reduced versus the non-reduced state of a protein can yield important structural 
information.

Before preparing the non-reduced sample, prepare a 250 mM iodoacetamide (IAM) solution. The IAM solution 
acts as the alkylating agent during preparation of the sample to minimize any heterogeneity created from 
partial auto-reduction of the protein.

Prepare the Alkylating Agent (250 mM IAM Solution)

1 Weigh 46 mg of iodoacetamide (IAM).

Tip! To remove bubbles from the micro vial, use a pipette to gently aspirate any bubbles.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
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SDS-MW Analysis Kit
2 Transfer the IAM to a 1.5 mL centrifuge tube.

3 Add 1 mL of DDI water to the 1.5 mL centrifuge tube.

4 Cap the tube tightly, mix thoroughly until dissolved, and then store in the dark at room temperature. The 

solution is stable for approximately 24 hours at room temperature.

Prepare Non-reduced Samples Using an Alkylating Agent

1 Dilute the sample with the SDS-MW Sample Buffer to a total volume of 95 μL to give a final protein 

concentration between 0.2 mg/mL to 2 mg/mL.

2 Add 2 μL of the 10 kDa Internal Standard to the protein sample tube.

3 Inside a fume hood, add 5 μL of the 250 mM IAM solution to the sample protein tube.

4 Cap the tube tightly, seal with Parafilm, and mix thoroughly.

5 Using a centrifuge, spin the tube for 1 minute at 300 g.

6 Heat the vial in a water bath at 70 °C for three minutes.

7 Using a centrifuge, spin the tube for 1 minute at 300 g.

8 Put the tube in a room-temperature water bath to cool for 5 minutes before injection.

9 Transfer 70 μL to 90 μL of the prepared sample to a micro vial. Put the micro vial inside a universal vial, 

then cap the universal vial. Make sure there are no bubbles in the micro vial.

Note: Under non-reducing conditions, heating the sample solution at high temperature is required to 
accelerate SDS binding. However, heating a protein sample at high temperature may introduce 
fragmentation and aggregation, and introduce artifacts to the sample analysis.

We recommend this alkylation step to minimize temperature-induced artifacts in the protein sample. We also 
recommend using one of the low pH SDS sample buffers for non-reduced samples. The Low pH SDS Sample 
Buffer has been proven to further reduce method-induced artifacts.
SDS-MW Analysis Kit For the PA 800 Plus 
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Prepare the PA 800 Plus System

This section describes the steps to prepare the PA 800 Plus System to acquire data.

The procedures described in this section assume the system has already been properly installed and 
initialized.

Install the PDA Detector

1 Turn off the PA 800 Plus System and then install the PDA detector. Refer to the System Maintenance Guide.

2 Turn on the system and permit the lamp to warm up for at least 30 minutes.

Clean the Interface Block

Clean the electrodes, opening levers, capillary tips, and interface block weekly or when changing chemistries. 
Refer to the System Maintenance Guide for detailed instructions.

The SDS-MW Gel Buffer is very viscous and can accumulate in the system unless regular and thorough 
cleaning is performed. Gel accumulation might cause broken capillaries, bent electrodes, vial jams, and missed 
injections.

Insert the Cartridge and Calibrate the Detector

Tip! To remove bubbles from the micro vial, use a pipette to gently aspirate any bubbles.

CAUTION: Potential System Damage. Do not allow the gel to accumulate on the electrodes, opening 
levers, capillary ends, and interface block. Gel accumulation might cause broken capillaries, bent 
electrodes, jammed vials, or missed injections.

Note: To make sure that the analysis results are consistent over time, we strongly recommend calibrating 
the detector each time it is installed in the PA 800 Plus System. Also calibrate the detector after replacing 
the capillary in the cartridge or installing a different cartridge.

Note: For Empower™ Software users, calibration instructions are located in the PA 800 Plus Empower™ 
Driver User Guide.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
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1 Remove the cartridge from the box and, if necessary, install the capillary.

2 Install the cartridge in the PA 800 Plus System. Refer to the System Maintenance Guide for detailed 

instructions.

3 Close the front panel.

4 Calibrate the detector.

Use the Calibration wizard, available from the Instrument Configuration dialog in the 32 Karat™ Software.

Load the Buffer Trays

Refer to Hazardous Substance Information for additional information.

The number of reagent vials depends on upon the number of method cycles. The methods have been 
developed to automatically advance the reagent vials after eight cycles, providing a fresh set of buffers every 
eight cycles.

1 Fill the gel rinse (Gel-R) vials with 1.2 mL of SDS-MW Gel Buffer.

2 Fill the gel separation (Gel-S) vials with 1.1 mL of SDS-MW Gel Buffer.

3 Fill the water (H2O) vials with 1.5 mL of DDI water.

4 Fill the NaOH and HCl vials with 1.5 mL of 0.1 M NaOH and 0.1 M HCl solutions, respectively.

DANGER! Toxic Chemical Hazard. Read the Safety Data Sheets for Acid Wash/Regenerating 
Solution (0.1 M HCl), Basic Wash Solution (0.1 M NaOH), and SDS-MW Gel Buffer before use.

Note: Before starting the separation, bring the SDS-MW Gel Buffer and the SDS-MW Sample Buffer to room 
temperature.

Note: Make sure to fill the buffer vials with SDS-MW Gel Buffer without producing bubbles and use the 
recommended volume. If the volume is too low (less than half the volume of the vial), the capillary and 
electrode might not be able to dip into the SDS-MW Gel Buffer during the separation. If the volume is 
too high, the SDS-MW Gel Buffer may accumulate on the capillary ends and electrodes, resulting in 
system failure.
SDS-MW Analysis Kit For the PA 800 Plus 
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SDS-MW Analysis Kit
5 Fill the waste vials with 1.0 mL of DDI water.

Figure 1  Universal Vial and Cap Setup

6 Cap the universal vials with the blue caps.

7 Load the reagent vials into the buffer trays as shown in Figure 2 and Figure 3.

CAUTION: Potential System Damage. Do not fill the waste vial with more than 1.8 mL. If the vial 
has more than 1.8 mL, the pressure system might be damaged.

1. Universal vial cap
2. Maximum fill line
3. Universal vial

IMPORTANT For this application, all vials and caps are designed for a maximum of eight runs. Do 
not reuse the caps because they might be contaminated with dried gel and other chemicals.
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Figure 2  Inlet Buffer Tray Layout

A1 to A6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B4 to B6: 1.5 mL, DDI H2O, used in dip step to clean capillary tip

B1 to B3: 1.2 mL SDS-MW Gel Buffer, used to rinse/fill capillary prior each cycle (Gel-R)

C1 to C3: 1.1 mL SDS-MW Gel Buffer, used for separation (Gel-S)

D1 to D3: 1.5 mL 0.1 M NaOH solution, used to precondition capillary

E1 to E3: 1.5 mL 0.1 M HCl solution, used to precondition capillary

F1 to F3: 1.5 mL DDI H2O, used to precondition capillary
SDS-MW Analysis Kit For the PA 800 Plus 
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Figure 3  Outlet Buffer Tray Layout

A1 to A6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B4 to B6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B1 to B3: 1.0 mL DDI H2O, waste for SDS-MW Gel Buffer rinse

C1 to C3: 1.1 mL SDS-MW Gel Buffer, used for separation

D1 to D3: 1.0 mL DDI H2O, waste for 0.1 M NaOH solution rinse

E1 to E3: 1.0 mL DDI H2O, waste for 0.1 M HCl solution rinse

F1 to F3: 1.0 mL DDI H2O, waste for DDI H2O rinse

Load the Sample Tray

1 Prepare the samples. For each sample:

a. Make sure the prepared samples are at room temperature.

b. Put 70 μL to 90 μL of the sample in a micro vial.

c. Make sure that no bubbles are present at the bottom of the vials. If bubbles are present, then use a 
centrifuge to spin the micro vials for 2 minutes at 1,000 g. Repeat if necessary.

Note: During electrophoresis the ionic strength of the buffer will change. The separation method is 
programmed to increment the buffer vials after eight runs to avoid ionic depletion.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System

RUO-IDV-05-6934-C  17 / 60



SDS-MW Analysis Kit
2 Put the micro vial in a universal vial, and then cap the universal vial.

Figure 4  Sample Vial Setup

3 Put the universal vials in the 48-position inlet sample tray from positions A1 through C8.

Figure 5  Sample Tray Layout

1. Universal vial cap

2. Micro vial

3. Universal vial

4. Micro vial inside universal vial
SDS-MW Analysis Kit For the PA 800 Plus 
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SDS-MW Analysis Kit
Run the Samples

Create the Sequence and Start the Run

1 Double-click the PA 800 Plus Software icon on the desktop.

2 In the PA 800 Plus window, click  (Run) in the upper right corner of the window.

3 In the Application list, click SDS MW. In the Sequence list, click Browse and select SDS MW - 24 samples - PA 

800 plus.

If system administration is enabled, type the user name and password when prompted, and then click OK 
Refer to Figure 6. The default user name is pa800, and the default password is plus.

Figure 6  User Name and Password Entry

The Instrument Status and Direct Control window opens. Refer to Figure 7.

Note: For Empower™ Software users, refer to Run the Samples with the Waters Empower™ Software.
Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System

RUO-IDV-05-6934-C  19 / 60



SDS-MW Analysis Kit
Figure 7  Instrument Status and Direct Control Window: Idle

4 In the Instrument Status and Direct Control window, click  (Next) in the bottom right corner of the 

window.

The sequence opens.

5 Select SDS MW - 24 samples - PA 800 plus to open the sequence. This sequence will run a maximum of 

24 samples where sample 1 is (always) the control standard.

6 Click  (Describe) in the upper right hand corner of the window to edit the sequence.

Use the Describe function to customize the sequence table and edit the number of samples that can be run 
in the sequence. The Describe function can set the row types as controls for system suitability standards 
and blanks, samples for unknowns, and when preparing for capillary conditioning and shutdown runs.

7 In the Application list, click SDS MW. In the Sequence list, click Browse, and then select SDS MW - 24 

samples - PA 800 plus. If prompted, type a user name and password.

The page updates to show the selected sequence, and all rows in the sequence are designated as samples.

8 (Optional) Edit the Sample ID and the Data File Name as desired.

Note: The Describe function can be accessed from the PA 800 Plus window, the application window, or 
the Samples/Vials window by clicking the Describe icon.
SDS-MW Analysis Kit For the PA 800 Plus 
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SDS-MW Analysis Kit
Editable fields such as Sample ID and Data File Name can be set as Mandatory, Optional, or Fixed.

9 After the sequence is loaded, set rows to Sample, Control, or Always. Click a row to select it and then click 

the button in the Rows area.

Capillary Conditioning and Shutdown runs are set as Always. Refer to In Figure 8. Sample ID is set as 
Optional. Reps are set as Required.

Figure 8  Describe sequence rows and columns Window – Conditioning Method Set to “Always”
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10 In the lower right corner of the window, click  (Save) and then click  (Finish). The Run 

Sequence window opens. Refer to Figure 9.

Figure 9  Describe sequence rows and columns Window – Reload Sequence

The number of samples shown for this sequence is 22 instead of 23 because the first run is the control. If 
required, the user can reduce the number the samples to be run in the sequence in the Run Sequence 
window by editing the Number of samples list.

11 Click Load to load the sample and reagent vials as shown in Figure 9 and then close the door.

Note: The Describe function can be accessed from the PA 800 Plus window, the application window, or 
the Samples/Vials window by clicking the Describe icon.

Note: In the upper left corner next to Run #1 of the table in Figure 9, a blinking red exclamation mark 
(not shown) indicates that the sequence has changed and that the software expects an action from the 
user. Move the cursor over the exclamation point to view a tooltip with the required action. In this 

example, the user is prompted to click  (Reload sequence) to update the sequence.

A required action is also used if in the data file name is a required field and the data file does not contain 
any information. In this case, the user is required to enter the appropriate data file name.
SDS-MW Analysis Kit For the PA 800 Plus 
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12 Click (Next) and then click Yes - run now.

Figure 10  PA 800 Plus System During Data Acquisition

Waste Disposal

Store the Cartridge

Store the Cartridge for Less Than 10 Days

1 Perform a shutdown method to clean the capillary.

The shutdown method fills the capillaries with water.

WARNING! Biohazard or Toxic Chemical Hazard. Follow local directives when disposing 
of chemicals, vials and caps, and the remains of the prepared samples, if applicable. 
They might contain regulated compounds and biohazardous agents.
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2 Store the cartridge for up to 10 days in the system with the capillary ends immersed in vials of DDI water.

Store the Cartridge for More Than 10 Days

1 Perform a shutdown method to clean the capillary.

2 Rinse the capillary with DDI water for 10 minutes at 100 psi.

3 Remove the cartridge from the system.

4 Store the cartridge upright in the cartridge box at room temperature, with the capillary ends immersed 

in vials of DDI water.

Prepare the Cartridge After Storage

 • If the cartridge has not been used for more than a day or it has been stored for an extended time, then 
condition the capillary using the SDS MW Conditioning method.
SDS-MW Analysis Kit For the PA 800 Plus 
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Analyze the Results

The SDS-MW Size Standard contains seven proteins (10 kDa, 20 kDa, 35 kDa, 50 kDa, 100 kDa, 150 kDa, and 
225 kDa). All proteins should be completely separated within 30 minutes using our recommended method. 
Refer to Figure 11 for a typical separation of the SDS-MW Size Standard.

Figure 11  Separation of SDS-MW Size Standard using SDS-MW Sample Buffer

Estimate the Protein Molecular Weights

Refer to Figure 12 for a typical calibration curve obtained by plotting the known molecular weight vs. 
migration time of each protein in the SDS-MW Size Standard. The molecular weight of an unknown protein 
can be estimated by using this calibration curve. The calculated molecular weights are displayed in the 
electropherogram by selecting Quality as an annotation.

Re-calibrate this curve every 24 cycles. This is done by running the SDS-MW Size Standard and updating the 
migration time values for each standard to reflect the new run. This update is performed in the qualitative 
analysis of the 32 Karat™ Software. Refer to Figure 12.

Note: The figure below is based on ideal results. Peak heights may vary depending on sample preparation 
and UV lamp life.
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Figure 12  Qualitative Analysis Dialog
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Troubleshooting

Table 4  Troubleshooting

Problem Possible Cause Corrective Action

Low or unsteady current resulting in 
slow migration and poor resolution 
resulting in failed system suitability 
test; current should be close to

–25 μA

Capillary plugged 1) Rinse the capillary with DDI water at 
100 psi for 10 minutes and then perform 
the capillary conditioning method.

2) If low or unsteady current continues, 
replace the capillary.

Air bubbles in the gel Degas SDS-MW Gel Buffer under 5 Hg to 
15 Hg vacuum for 5 minutes.

High current Contaminated gel buffer Replace the SDS-MW Gel Buffer as 
needed.

Contamination of the electrode Clean the electrodes. Refer to the System 
Maintenance Guide.

Spikes in electropherogram Air bubbles in gel buffer Degas SDS-MW Gel Buffer under 5 Hg to 
15 Hg vacuum for 5 minutes.

Broad peaks, poor resolution Poor capillary end cut Inspect the capillary end under 
magnification. If the cut is jagged, then 
cut the end again or replace the capillary.

Improper reduction of sample Reduce the sample using recommended 
procedure. Use fresh 2-mercaptoethanol 
for sample reduction. Refer to Prepare the 
Samples.

Deteriorated capillary Replace the capillary when other 
attempts to reduce peak broadening fail.

1) Rinse the capillary with DDI water for 
10 minutes at 100 psi and then perform 
the capillary conditioning method.

2) Install a new capillary if the same 
problem is observed.

Dust or gel build up on capillary end Clean the capillary tip using DDI water. 
Refer to Clean the Interface Block.
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No peaks or low signal Capillary inlet longer than the inlet 
electrode

Push the capillary up inside the cartridge 
or cut the capillary inlet to make sure it is 
the same length as the electrode.

Dirty or plugged capillary tip 1) Clean the capillary tip using DDI water. 
Refer to Clean the Interface Block.

2) Replace the capillary if the plug cannot 
be removed.

Not enough sample Make sure there is a minimum of 20 μL of 
sample in the sample vial.

Slow sample migration Increase the separation time in the 
method and repeat the analysis.

High salt in protein sample Perform a buffer exchange to remove salt 
from the sample. Refer to Perform a Buffer 
Exchange for the Protein Sample.

Table 4  Troubleshooting (Continued)

Problem Possible Cause Corrective Action
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APPENDIX A

Hazardous Substance Information

The following information must be noted and the relevant safety measures taken. Refer to the respective 

safety data sheets for more information. These are available upon request or can be downloaded from our 
website, sciex.com/tech-regulatory.

Hazard classification is according to HCS 2012.

Acid Wash/Regenerating Solution (0.1 M HCl)

Basic Wash Solution (0.1 M NaOH)

Low pH SDS Sample Buffer (100 mM Tris-HCl, pH 6.8, 1% SDS)

DANGER! Causes severe skin burns and eye damage.

DANGER! Causes severe skin burns and eye damage.

WARNING! Causes mild skin irritation.
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Hazardous Substance Information
Low pH Phosphate SDS Sample Buffer (40 mM Phosphate, pH 6.5, 
1% SDS)

SDS-MW Sample Buffer (100 mM Tris-HCl, pH 9.0, 1% SDS)

SDS-MW Gel Buffer, proprietary formulation (pH 8.0, 0.2% SDS)

Other Reagents

These components are not classified as hazardous:

 • SDS-MW Size Standard

 • Internal Standard, 10 kDa protein, 5 mg/mL

For reagents from other vendors, read the Safety Data Sheet from the vendor before use.

WARNING! Causes mild skin irritation.

WARNING! Causes mild skin irritation.

DANGER! Causes mild skin irritation. May damage fertility or the unborn child.
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APPENDIX B

Methods

The SDS-MW Analysis Kit application requires three methods. The methods are installed with the software 

and are not available f or download. The following figures are provided for reference.

Initial Conditions

Figure B.1  Initial Conditions for All Methods

Note: The values on the Initial Conditions and PDA Detector Initial Conditions tabs are the same for all of the 
methods.

Note: The values on the Initial Conditions and PDA Detector Initial Conditions tabs are the same for all of the 
methods.
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Methods
Detector Initial Conditions

Figure B.2  PDA Detector Initial Conditions for All Methods

Time Programs

The time programs are different for each method.

Figure B.3  Time Program for SDS MW Conditioning Method
SDS-MW Analysis Kit For the PA 800 Plus 
Pharmaceutical Analysis System

Application Guide

32 / 60 RUO-IDV-05-6934-C



Methods
Figure B.4  Time Program for SDS MW Separation Method

Figure B.5  Time Program for SDS MW Shutdown Method
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Methods
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APPENDIX C

Using the Low pH SDS Sample Buffer
Some samples may be more stable in a sample buffer with a lower pH. To use the Low pH SDS Sample Buffer 
(pH 6.8), prepare the samples as described previously, but replace the SDS-MW Sample Buffer with the Low pH 
SDS Sample Buffer (pH 6.8).

Due to the increased ionic strength of low pH sample buffers, we recommend modifying the SDS-MW 
separation method by increasing the injection voltage or duration to avoid any signal loss. Adjust the 
separation time based on the samples to be analyzed. For example, for analysis of a Rituxan (rituximab) 
sample, change the separation time to 35 minutes.

Alternatively, use a pressure injection in the separation method. Start with the same SDS-MW separation 
method as for samples prepared with the SDS-MW Sample Buffer and edit the method as described in the 
following section.

Add a Pressure Injection to the SDS MW Separation Method

Use the following instructions to add a pressure injection and make other necessary changes to the separation 
method.

1 Open the SDS MW separation method in the 32 Karat™ Software.

No changes to the Initial Conditions or the PDA Detector Initial Conditions are required.

2 Click the Time Program tab.

3 Add a Rinse event after row 5. Set the parameters as shown.

Note: SCIEX carries two different low pH sample buffers, the Low pH SDS Sample Buffer (Tris; pH 6.8) and 
the Low pH Phosphate SDS Sample Buffer (pH 6.5).
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Using the Low pH SDS Sample Buffer
Figure C.1  Rinse Dialog

4 Edit the Inject-Voltage event to match the following figure.

Figure C.2  Inject Dialog

5 Adjust the duration of the Separation-Voltage event based on samples to be analyzed.

The time program should match the following figure.
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Using the Low pH SDS Sample Buffer
Figure C.3  Separation Method Time Program after Editing (showing Rinse and Injection Pressure Events)

6 Save the method. If the method name is not changed, then no changes to the sequence are required.

Results Obtained Using the Low pH SDS Sample Buffer

The following figure shows the results obtained with Rituxan (rituximab) and the Low pH SDS Sample Buffer. 
Refer to Figure C.4. Sample impurity was 1.35%.

Figure C.4  Rituxan (rituximab) Electropherogram Using the Low pH SDS Sample Buffer (Tris)
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Using the Low pH SDS Sample Buffer
A comparison of results obtained with the SDS-MW Sample Buffer (red trace) and the Low pH SDS Sample 
Buffer (blue trace) with the Rituxan (rituximab) is shown in the following figure.

Figure C.5  Comparison of SDS-MW Sample Buffer and Low pH SDS Sample Buffer (Tris) for Rituxan (rituximab)
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APPENDIX D

Using the Low pH Phosphate SDS Sample Buffer
About the Low pH Phosphate SDS Sample Buffer

The Low pH Phosphate SDS Sample Buffer is designed to meet specifications provided in the Chinese 
Pharmacopeia set forth by the Pharmacopoeia Commission of the Ministry of Health of the People’s Republic 
of China for capillary electrophoresis SDS separations.

In addition to specifying the buffer, the Chinese Pharmacopeia (2019-06-27) has recommendations for the 

separation method. Refer to Chinese Pharmacopeia 2020 Edition, Chapter 3127, 3127  单抗分子大小变 异体
测定法 (CE-SDS法) or https://www.chp.org.cn/gjydw/swzp/5032.jhtml. The link was current at the time of 
publication.

Note: SCIEX carries two different low pH sample buffers, the Low pH SDS Sample Buffer (Tris; pH 6.8) and 
the Low pH Phosphate SDS Sample Buffer (pH 6.5).

Note: The Chinese Pharmacopeia specifies a range for some assay parameters instead of a single value. For 
the results in the following figures, the median was used. Specifically, the sample incubation temperature 
was 70 °C and the sample storage and capillary temperatures were 20 °C.
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Using the Low pH Phosphate SDS Sample Buffer
Results Obtained Using the Low pH Phosphate SDS Sample Buffer

Typical Results Using Non-reducing Conditions

The following figure shows the results obtained with NIST mAb and the Low pH Phosphate SDS Sample Buffer 
following the Chinese Pharmacopeia method under non-reducing conditions.

Figure D.1  Electropherogram of Non-reduced NIST mAb Using the Low pH Phosphate SDS Sample Buffer with the 
Chinese Pharmacopeia Method
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Using the Low pH Phosphate SDS Sample Buffer
Typical Results Using Reducing Conditions

The following figure shows the results obtained with NIST mAb and the Low pH Phosphate SDS Sample Buffer 
following the Chinese Pharmacopeia method under reducing conditions.

Figure D.2  Electropherogram of Reduced NIST mAb Using the Low pH Phosphate SDS Sample Buffer with the Chinese 
Pharmacopeia Method

 • LC: light chain

 • NGHC: non-glycosylated heavy chain

 • HC: heavy chain
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APPENDIX E

Run the Samples with the Waters Empower™
Software

This section gives instructions on data acquisition using the Empower™ Software. Refer to the Empower™ 

Software guides and help file for data analysis instructions.

Create the Instrument Methods

Three instrument methods are required:

 • SDS MW_CONDITIONING

 • SDS MW_SEPARATION

 • SDS MW_SHUTDOWN

1 In the Empower™ Software Project window, click File > New Method > Instrument Method.

The Select Desired Chromatography System dialog opens.

Note: Calibrate the PDA detector before acquiring data. Refer to the PA 800 Plus Empower™ Driver User 
Guide for instructions.

Note: If a low pH SDS sample buffer is used, the instrument methods might need adjustments to 
accommodate the increased ionic strength of the buffer. Refer to Using the Low pH SDS Sample Buffer.

Note: The values in the General and Detector tabs are the same for all of the methods.

Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi), depending on a 
registry setting for the Empower™ Software. The default unit is millibar. To change the units, refer to the
PA 800 Plus Empower™ Driver Release Notes.

Note: The instrument methods that follow were validated using the SDS-MW Sample Buffer.
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Run the Samples with the Waters Empower™ Software
Figure E.1  Select Desired Chromatography System Dialog

2 Click the system to be used and then click OK. Make sure that the instrument is configured with a 

PDA detector. 

The Instrument Method Editor opens.

3 Set the parameters in the General tab.

Figure E.2  General Parameters for the SDS MW_CONDITIONING Instrument Method
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Run the Samples with the Waters Empower™ Software
4 Click the Detector tab, select PDA in the Detector Type list, and then set the parameters.

Figure E.3  Detector Parameters for the SDS MW_CONDITIONING Instrument Method

5 Add the events in the following figure to the time program.

Figure E.4  Time Program for the SDS MW_CONDITIONING Instrument Method

Note: For 3D data, in Electropherogram Scan Data, select On for Data Rate.

Note: For the pressure in the Separate Voltage Pressure event (step 5), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1, 2, and 3), type 1379.0.

 • For the pressure in the Rinse Pressure event (step 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.
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6 Save the instrument method.

a. Click File > Save. The Save current Instrument Method dialog opens.

b. Type SDS MW_CONDITIONING in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.

The instrument method is saved to the current project.

7 Create the separation instrument method.

a. Set the parameters on the General tab. Refer to Figure E.2.

b. Set the parameters on the Detector tab. Refer to Figure E.3.

c. Add the events in the following figure to the time program.

Figure E.5  Time Program for the SDS MW_SEPARATION Instrument Method

d. Save the method as “SDS MW_SEPARATION”.

Note: For the pressure in the Separate Voltage Pressure event (step 9), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 through 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 9), type 1379.0.
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8 Create the shutdown instrument method.

a. Set the parameters on the General tab. Refer to Figure E.2.

b. Set the parameters on the Detector tab. Refer to Figure E.3.

c. Add the events in the following figure to the time program.

Figure E.6  Time Program for the SDS MW_SHUTDOWN Instrument Method

d. Save the method as “SDS MW_SHUTDOWN”.

Create the Method Sets

Three method sets are required:

 • SDS MW Conditioning Method Set

 • SDS MW Separation Method Set

 • SDS MW Shutdown Method Set

1 In the Empower™ Software Project window, click File > New Method > Method Set.

2 Click No in the message.

The Method Set Editor window opens.

Note: For the pressure in the Separate Voltage Pressure event (step 5), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 and 4), type 4826.3.

 • For the pressure in the Rinse Pressure events (steps 2 and 3), type 3447.4.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.

Note: A method set can also include processing and report methods. To create those methods, refer to the 
documentation supplied with the Empower™ Software.
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3 In the Instrument Method list, click SDS MW_CONDITIONING. Do not make any other changes.

Figure E.7  Method Set Editor Window

4 Save the method set.

a. Click File > Save to open the Save current method set dialog.

b. Type SDS MW Conditioning in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.
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Figure E.8  Save current method set Dialog

The method set is saved to the current project.

5 Repeat the previous steps to create two more method sets.

a. Create the separation method set by selecting SDS MW_SEPARATION in the Instrument Method list.
Save the method set as “SDS MW Separation”.

b. Create the shutdown method set by selecting SDS MW_SHUTDOWN in the Instrument Method list.
Save the method set as “SDS MW Shutdown”.

Configure the Software to Use Multiple Plates

The Empower™ Software is designed for chromatography systems that do not have buffer trays. To use the 
buffer trays, configure the Empower™ Software as follows.
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1 In the Empower™ Software Run Samples window, click Edit > Plates.

The Define Plates for Sample Set Method dialog opens.

Figure E.9  Define Plates for Sample Set Method Dialog

2 In the first row, set up the buffer inlet tray.

a. Click the Plate Type Name cell and then select PA 800 Plus Buffer Tray.

The dialog updates with an image of the plate and buttons for the plate sequencing mode.

b. Click the Plate Layout Position cell and then type BI.

c. Click  (Vertical Discontinuous Plate Sequencing Mode) to indicate the order in which the vials are 
accessed during the run.

Note: If the dialog does not look like the previous figure, clear the 2790 Layout check box.

Note: If PA 800 Plus Buffer Tray is missing, then the buffer and sample trays might not have been 
defined. Refer to the PA 800 Plus Empower™ Driver User Guide.
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Figure E.10  After Defining the Buffer Inlet Plate

3 Repeat step 2 to set up the buffer outlet tray in the second row. Type BO for the Plate Layout Position.

4 In the third row, set up the sample inlet tray.

a. Click the Plate Type Name cell and then select the correct plate type, either PA 800 Plus Sample Tray 

or PA 800 Plus 96 Well Sample Tray.

b. Click the Plate Layout Position cell and then type SI.

c. Click  (Vertical Discontinuous Plate Sequencing Mode) to indicate the order in which the vials are 
accessed during the run.

5 Repeat step 4 to set up the sample outlet tray in the fourth row. Type SO for the Plate Layout Position.
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Figure E.11  After Defining All Plate Types

6 Click OK to save the changes and close the dialog.

Create the Sample Set Method and Run the Samples

1 In the Empower™ Software Project window, click File > New Method > Sample Set Method.

The New Sample Set Method Wizard opens.

2 Click Use the Sample Set Method Editor instead of the wizard and then click Next.
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Figure E.12  New Sample Set Method Wizard

The Sample Set Method Editor opens.

3 Set up the Sample Set Method.

a. In the first row, select SDS MW Conditioning in the Method Set/Report or Export Method cell.

b. For rows 2 through 17, select SDS MW Separation in the Method Set/Report or Export Method cell.

c. For row 18, select SDS MW Shutdown in the Method Set/Report or Export Method cell.

d. Add the required information for the samples. Refer to Table E.1. Use the default values for the other 
fields.

The completed Sample Set Method is shown in the following figure.

Table E.1  Required Fields for a Sample Set Method

Name Description

Plate/Well The position of the sample in the sample tray.

# of Injs The number of times the sample is to be injected.

SampleName The name of the sample.

Run Time (Minutes) The duration of the run.

CAUTION: Possible Wrong Result. Make sure that the Run Time is greater 
than or equal to the duration of the time program in the instrument 
method. If the Run Time is shorter, the system stops the run before the time 
program is complete.

Note: The Level and Reference Level columns are hidden in the following figure.
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Figure E.13  Sample Set Method

4 Save the Sample Set Method.

a. Click File > Save.

The Save current sample set method dialog opens.

b. Type SDS MW Sample Set Method in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.

The method set is saved to the current project.
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5 Click Tools > Run Samples.

Figure E.14  Select Desired Chromatography System Dialog

6 Click the system to be used and then click OK. Make sure that the instrument is configured with a 

PDA detector.

The Run Samples window opens.

7 Click  (Load Sample Set).

The Load Samples dialog opens.

8 Click Load using a previously created sample set method and then click OK.

Figure E.15  Load Samples Dialog
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Figure E.16  Open an existing sample set method Dialog

9 Click SDS MW Sample Set Method in the list and then click Open.

The sample set method opens in the Samples tab.

10 In the Empower™ Software Project window, click  (Start). Data acquisition starts.

During the run, the text in the row in the Sample Set Method window for the sample being acquired 
appears red.

11 During the run the following actions are available:

 • (Optional) Click  (Stop) to halt data acquisition.

 • View the voltage and current data.

When the run ends, the text in all rows in the Sample Set Method window appears red.
SDS-MW Analysis Kit For the PA 800 Plus 
Pharmaceutical Analysis System

Application Guide

56 / 60 RUO-IDV-05-6934-C



Application Guide SDS-MW Analysis Kit For the PA 800 Plus
Pharmaceutical Analysis System

RUO-IDV-05-6934-C  57 / 60

Revision History
Initial Issue, A51970AA, April 2009
32 Karat™ Software version 9.1

PA 800 plus Software version 1.1

PA 800 plus Firmware version 9.0

First Revision, A51970AB, December 2009
Revised corporate address

Second Revision, A51970AC, February 2011
32 Karat™ Software version 9.1 patch

PA 800 plus Software version 1.1 patch

PA 800 plus Firmware version 9.2

Numerous syntax and grammatical edits

Third Revision, A51970AD, January 2014
Dimension & instruction edit

Fourth Revision, A51970AE, RUO-IDV-05-6934-A, April 2018
Rebranded. Applied new template. Legal content updated. Safety chapter removed and a reference to the 
safety content found in the System Overview Guide added. Replaced instructions for creating methods with 
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Applied new template. Legal content updated. Added low pH SDS sample buffer including sample preparation 
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Sixth Revision, RUO-IDV-05-6934-C, July 2020
Updated Legal Content. Updated Introduction. Added Store the Cartridge for Less Than 10 Days. Updated 
Appendix A, Hazardous Substance Information. Added Appendix C, Low pH SDS Sample Buffer, including 
sample preparation instructions. Added Appendix D, Low pH Phosphate SDS Sample Buffer. Added 
Appendix E, Run the Samples with the Waters Empower™ Software. Updated Contact Us.

This guide applies to the latest software and firmware listed above, and any higher subsequent versions. When a 
subsequent software or firmware version affects the information in this guide, a new issue will be released to the 
SCIEX website. For updates, go to sciex.com and download the latest version of the guide.
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Contact Us
Customer Training

• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

• SCIEX University™

Purchase Consumables

Reorder SCIEX consumables online at store.sciex.com. To set up an order, use the account number, found 
on the quote, order confirmation, or shipping documents. The SCIEX online store is currently limited to the 
US, UK, and Germany but will be expanding to other countries in the future. For customers in other countries, 
contact the local SCIEX representative.

SCIEX Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located 
throughout the world. They can answer questions about the system or any technical issues that might arise. 
For more information, visit the SCIEX website at sciex.com or contact us in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support
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Contact Us
CyberSecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation

This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest version, go to 
https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide that comes 
with the software.

To find hardware product documentation, refer to the Customer Reference DVD that comes with the system or 
component.

The latest versions of the documentation are available on the SCIEX website, at
 sciex.com/customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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